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Thank for your purchase of Audirvana Plus, the audiophile player that we hope will give 
you great musical moments with your Mac, giving you the Sound of Your Dreams.

The next level in Sound Quality for your Mac
• Automatic sample rate switching
• Shortest audio realtime stream, bypassing the CoreAudio high-level processing of 

the audio signal
• Exclusive access, and Integer Mode enabling to push the optimization at the audio 

device driver level by feeding it with signal already in the device native format
• Direct Mode for bypassing the CoreAudio low-level processing of the audio signal, 

and enabling Integer Mode in Lion and later
• Full  memory play with complete loading, decoding, sample rate and format 

conversion (as needed) of the tracks before playing
• 64-bit internal processing of the audio signal (when processing is needed)
• Multichannel playback on multichannel devices
• Configurable up/over sampling
• iZotope 64-bit SRC best in class sample rate conversion algorithm
• Dithered volume control with iZotope MBIT+ dithering highly advanced algorithm 

with auto bypass
• Audio Units plugins support for deep sound tuning
• SysOptimizer disabling the OS X background services potentially interfering with 

sound quality
• Automatic volume leveling, with ReplayGain and Loudness Dynamic Range 

analysis

With the convenience of a complete library manager
• Very fast library navigation, even with huge libraries (e.g. 250,000+ tracks)
• Automated synchronization of your music folders
• All the file formats Audirvana Plus can play are directly cataloged (no need for any 

proxy file)
• Advanced metadata editing, including the extended fields for classical music, 

multiple artists
• Album view with grouping by user selectable criteria (e.g. genre, composer, album 

artist)
• Structured filter browser to quickly narrow the search for the music you want to 

listen to
• Smart playlists, Full text search
• Hyperlink navigation on albums, artists

Streaming Service complete integration: Qobuz, TIDAL, HighResAudio VirtualVault
• Access the huge available catalog of the streaming service
• Play with the same Sound Quality as for local files

And ability to be remote controlled from A+ Remote for iPhone, iPad, iPod touch
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Always with modern convenience
• Device hot-plugging support, along with automatic features detection making 

optimal configuration a breeze
• Media Keys, Apple IR Remote for ease of control

And all popular file formats
• AIFF, WAVE, AAC, MP3
• FLAC, Monkey Audio APE, WavPack, Apple Lossless
• DSD (DSDIFF including DST compressed, DSF, and SACD ISO images) with 

native streaming to supported DACs, or through high quality realtime 
conversion to PCM

• MQA with first unfolding (playing the 88.2kHz or 96kHz content of 2x or more 
MQA audio files).

�3



Audirvana Plus 3.0 User Manual

Table	of	Contents	

1. Quick	Start	Guide	 5	...........................................................................................................

2. Main	Window	 8	................................................................................................................
Transport	controls	 8	......................................................................................................................................................................
Currently	playing	track	info	 10	.................................................................................................................................................
Libraries	&	playlists	 11	.................................................................................................................................................................
Adding	tracks	to	the	Play	Queue	 12	........................................................................................................................................

3. Library/Playlist	views	 13	...................................................................................................
Tracks	list	view	 13	..........................................................................................................................................................................
Albums	view	 15	...............................................................................................................................................................................
Switching	views,	highlighting	playing	track	 19	.................................................................................................................
Recycle	bin	 20	...................................................................................................................................................................................
Hyperlink	navigation		 20	.............................................................................................................................................................
Full	Text	Search		 22	........................................................................................................................................................................

4. Metadata	ediEng	 23	.........................................................................................................
Generic	commands	 23	..................................................................................................................................................................
Single	track	metadata	editing	 25	..............................................................................................................................................
Multiple	tracks	 28	...........................................................................................................................................................................
Album	 29	............................................................................................................................................................................................
Example	of	metadata	mass	update	 29	...................................................................................................................................
Artists	Editor	 30	..............................................................................................................................................................................

5. Legacy	iTunes	integrated	mode	 31	....................................................................................
Transport	Buttons	 31	....................................................................................................................................................................
Volume	Control	 31	..........................................................................................................................................................................
Other	buttons	 32	.............................................................................................................................................................................
Track	playing	position	 32	............................................................................................................................................................

6. User	Preferences	 33	..........................................................................................................
General	Settings	 33	........................................................................................................................................................................
Audio	System	Settings	 34	............................................................................................................................................................
Audio	Filters	Settings	 37	..............................................................................................................................................................
Audio	Volume	Settings	 39	...........................................................................................................................................................
Audio	Units	 41	..................................................................................................................................................................................
SysOptimizer	 43	..............................................................................................................................................................................
Library	 44	...........................................................................................................................................................................................
Streaming	account	 46	...................................................................................................................................................................
iTunes	[Only	for	legacy	iTunes	integrated	mode]	 47	......................................................................................................

7. Setup	&	OpEmizaEon	 47	...................................................................................................
Selecting	the	DAC	for	audio	output	 47	...................................................................................................................................
Note	for	Macs	before	2008	end	 47	..........................................................................................................................................
General	Optimizations	 48............................................................................................................................................................

�4



Audirvana Plus 3.0 User Manual

1. Quick	Start	Guide	
The first time you launch Audirvana Plus, you get a wizard dialog helping you to quickly 
and easily make the initial setup to get started:

1. Select the Audio Device you want to use for playback. Note that it needs to be 
connected for being in the list. If it is not at the time you have launched 
Audirvana Plus, you can connect it now and it’ll appear in this list. 

Click on Next to go to the next page
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2. Select the folders that contains your music to get it imported in Audirvana Plus. It 
is better to limit the number of folders in this list by selecting « parent » folders 
that contains a hierarchy of music folders, instead of selecting each individual 
album folder. 
Press the « + » button located bottom left of the list to select a new folder to add.

You can also directly import the contents of your iTunes music library by clicking 
on « Sync » in the 2nd method section. This is needed only if you have playlists 
in iTunes you want to import as well.
Click Next to go to the next page
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3. Login into your streaming service 

Click own « Connect » to enter your login and password of the streaming service: 
Qobuz, TIDAL, HighResAudio VirtualVault. 
To subscribe for the service, see directly with the service ( qobuz.com, tidal.com,  
highresaudio.com )  
With your Audirvana Plus purchase, you get vouchers for extended trial periods for 
the Qobuz and TIDAL. 
Click on Next to complete the initial setup. 

4. Setup is done! 

Click on Close. 
It’s now time to enjoy your Music !
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2. Main	Window	

Audirvana Plus main window is composed of 4 zones:
1. Top: The transport controls (e.g. Play, Pause, Next) and currently playing track 

info
2. Left: The Play Queue (list of tracks currently playing), the whole Music library, 

and the hierarchical list of playlists
3. Center: The albums, or tracks list view of the item selected on the left
4. Right: If visible, the metadata editor of the selected item(s) in the center

Transport	controls	

�
On the left are the main playback control buttons: 
Prev: Jump to beginning of current track, or to previous track if already at the beginning
Keyboard shortcut: Cmd ç

�8

2
3 4

1



Audirvana Plus 3.0 User Manual
Play: Starts the audio playback, and the following initialization steps (if enabled in the 
user preferences):

- Take exclusive access of the audio device
- Select native device format audio stream for playback (integer mode)
- Deactivate the background process that might have been interfering (e.g. 

TimeMachine, Spotlight,...). Note that this one is not enabled by default.
- Start loading the first track, and the next one

And finally audio playback is started.
This button becomes a pause button when playing.
Keyboard shortcut: Space

Pause: Pause the playback.
This exactly means output silence to the device, and pause playback. Please note the 
audio device is still active and fully controlled by Audirvana Plus.
This button becomes a resume button (Play icon) when in pause mode.
Keyboard shortcut: Space

Next: Jump to Next track
Keyboard shortcut: Cmd ➔

Stop: Fully stop audio playback, release the audio device, and restore the deactivated 
OSX services.

Below these buttons is the volume slider to control the audio volume level.
If the device provides no volume remote control and dithered volume control is not 
enabled in user preferences, the volume control slider is not shown.

And the last line gives the current settings of the DAC: bitdepth and sample rate.
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Currently	playing	track	info	

�
The currently playing track info is composed of:

- The album cover art thumbnail (when available). Clicking on the image opens a 
popup window with the full scale image of the album art.

- The track title
- The track artist name
- The composer followed by the album name
- The file format, bitdepth, sample rate, and channels information on the right
- The volume leveling applied to the currently playing track (if active):

�  

Time information is given on the bottom line:
- Elapsed time in minutes:seconds on the left
- Track total duration (or remaining time) on the right, switching between the two is 

done by clicking on it
- The graphical cursor moving from left to right, representing the current play 

position
o Dragging the playing position cursor or clicking directly on a different 

position makes the playback seek to this position.
o Inside this playing position bar is given information about the loading 

progress, in form of a grey progress bar. If the whole track can’t fit in a 
single buffer, then the parts of the track currently in memory are shown in 
dark grey, while the others are in black.

- Right of the total/remaining time are two icons for loop & shuffle play. Clicking on 
one switches the on/off status of loop playback (loop to the first play queue track 
when the last track has been played), or shuffle (play in random order)

Three indicators are under the file sample rate information (bottom right):
- INT: the playback is performed in Integer Mode. Best possible quality.
- Inverted icon: the yellow inverted icon indicates that the currently playing track 

audio signal is phase inverted before being sent to the DAC
- SysOpt: SysOptimizer is in operation when this is displayed in green, and 

scheduled to stop when displayed in brown. (SysOptimizer is automatically 
stopped on minute after playback has been fully stopped).
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Libraries	&	playlists	
On the left of the main window is the list of libraries, and playlists:

�

Play	Queue	
This is the list of tracks that have just been, or are about to be played

�
o Tracks that have been played are displayed in grey,
o Currently playing track in black, with small loudspeaker icon
o Tracks about to be played later, in black

Music	
The whole music library cataloged by Audirvana Plus

Playlists	
Hierarchical list of folders of playlists.
The playlists can be reordered in the hierarchy using drag and drop operation.
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The bottom toolbar buttons give access to playlists actions:

�                               �
o New Playlist: Creates a new playlist to store and order manually tracks
o New Smart Playlist: Creates a new playlist automatically populated with tracks 

matching some defined criteria. These criteria are defined in the window that 
pops up.

o New Folder: Creates a folder to store playlists
o Import playlist…: Creates a new playlist from the tracks referenced in a playlist 

file (M3U format). Note that only the playlist tracks found in the library will be in 
the newly created playlist

o Edit Smart Playlist: Pops up the window to edit the criteria to select the tracks that 
are in the selected playlist

o Delete Playlist: removes the selected playlist
o Export playlist…: Saves in a playlist file (M3U format) references to the tracks in 

the playlist to be exported. If the playlist is made from criteria (“smart playlist”) 
then the criteria are also saved in the playlist file for re-creating a smart playlist 
when importing the created M3U file in Audirvana Plus. Please note that multi-
tracks files (SACD ISO, Cue Sheets) are not supported by the M3U standard.

These playlist actions can also be accessed through the File menu and a secondary 
click (Or Ctrl+click) on a playlist that reveals a popup menu of the possible actions.

Adding	tracks	to	the	Play	Queue	
Any track, playlist, album can be added to the end of the Play Queue by drag and 
dropping them on "Play Queue" (on the list on the left of the main window)
Double clicking on a track, album will start playback with it, replacing the Play Queue 
with:

- the album tracks when double clicking on an album, or a track in an album (in 
album view mode)

- the playlist (or whole library) tracks when double clicking on a track in tracks list 
view mode

The Play Queue can be reordered by drag and dropping tracks to their new place in the 
queue.

In addition, tracks from outside the library can be directly added to the Play Queue. Just 
drag tracks from iTunes, or files, playlists (.m3u or .m3u8), folders from the Finder and 
drop them on the Play Queue.
These tracks are not added to the library, they are just in the Play Queue. Thus they 
can’t be copied, nor be edited in the metadata editor.
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3. Library/Playlist	views	

Tracks	list	view	
The tracks list view presents the tracks in the whole library, or in a playlist according to 
the selection in the left panel list.

�
The tracks are shown in a list view, with the displayed columns as selected by the user. 
This selection is done in a popup menu that is raised by a secondary click (or Ctrl + 
Click) on the list header row.

�
Columns can then be resized and reordered using mouse dragging operations.

The row that has the mouse over shows three buttons:
• a play pause button left of the track title: to pause playback if it is the row of 

the playing track, or to start playback for this track (double clicking on the row 
performs the same action).

• a heart icon that enables to set/unset the track in the Favorites. Clicking on it 
switches the album in/out of the favorites list that is accessible from the 
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Sources list: 

�
• a « … » menu that popups a menu for actions: 

�
• Play Next: to add the selected tracks to the play queue just after the 

currently playing track
• Add to Play Queue: to add the selected tracks to the end of the play 

queue
• Add to Playlist: to add the selected tracks to the end of the playlist 

selected in the submenu

SorEng	
The sort order of the tracks can be changed by clicking on a table column header. Doing 
this will add the column as the first sort criteria (in the order shown by the small arrow).
It can be also configured by raising the View Options window (using the View menu 
command Show View Options, or Cmd J shortcut)

�
In this view Options window, the list shows the sort criteria by decreasing order of 
priority. They can be changed by clicking on them, along with the order (ascending & 
descending). The priorities can be reordered by dragging sort criteria to their new place.

Filtering	with	the	Structured	filter	browser	
The line of text located just above the list gives a summary of the structured filter 
currently active:
�
Clicking on it expands the structured filter browser view
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�

The structured filter is made of successive filters, ordered from left to right. The items 
selected in the first filter give a filtered list of tracks that provide the values for the 
second criteria. And so on for the next ones.
So this enables to narrow the search by successive steps. As an example, you can 
select first the genre, and keep only classical, then the composer, here Bach & 
Beethoven, then the Grouping (piece name)
To select/change a criteria, click on the button at the top of the filter step box, this raises 
a menu of the available criteria as shown below
Then you can select the items you want to retain in the values list for filtering the tracks.
And so on...
Selecting a blank criterion disables the specific filter, and is the equivalent of selecting 
the "All …" line in the values of the filter.

And the tracks list below is showing the tracks of the library/playlist filtered by both the 
structured filter and the search field.

DeleEng	tracks	
By pressing the Backspace key, the selected tracks are moved to the recycle bin of 
Audirvana Plus. This also removes the track from any playlist it was referenced in. The 
corresponding audio files are untouched, but their tracks are no more visible in the 
library, except by view the Recycle bin.

Albums	view	
The albums view presents the albums by their front cover image (also called album 
artwork) when available, with their title, and below the album artist or composer (as 
selected in the view options)
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�
The size of the front cover image is adjustable with the slider located at the bottom left of 
this view.
The album front cover image can be modified by dropping an image on the album 
displayed one either in the albums collection view, or in the album tracks view
The two buttons located at the bottom right are visible when grouping is enabled (see 
below for more).

Note	on	audio	files	missing	Album	Etle	metadata	
Albums are created from tracks inside the same folder sharing the same album title and 
album artist name metadata. And these metadata are used throughout Audirvana Plus to 
filter and sort on album information.
Some audio files may be missing album metadata information (e.g. they have no such 
album title). They are grouped by folders into albums that use the folder name as title, 
and the folder parent name as artist name. This enables all to use all the display, 
navigation and search features with them.
Metadata is saved into the audio files when editing it. 

Album	vigneUe	acEons	
By moving the mouse over an album vignette, three active controls are revealed:
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�
• The play/pause button in the center. Clicking on it pauses playback if this is 

the currently playing album, or starts playing back this album otherwise.
• The favorites switch (heart icon) bottom left. Clicking on it switches the album 

in/out of the favorites list that is accessible from the Sources list: 

�
• The « more » actions (« … » bottom right) that raises a popup menu to: 

�
• Play Next: to add the selected album to the play queue just after the 

currently playing track
• Add to Play Queue: to add the selected album to the end of the play 

queue
• Add to Playlist: to add the selected album to the end of the playlist 

selected in the submenu
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Viewing	an	album	tracks	
Clicking on an album front cover image outside of the active buttons opens its detailed 
view, revealing the tracks that compose it and are present in the selected playlist/library.

�

The tracks list is sorted by track number and the rows are grouped according to the 
"Grouping" (or musical piece) information. This enables to quickly see the pieces and 
their movements (e.g. in classical music). When different composers are on the same 
album, the composer is displayed inside parentheses on the "Grouping" row.
Dragging a grouping row to the Play Queue or a playlist will take all the tracks inside the 
grouping.
In addition, below the album front cover enlarged view (see “R” blue sign) is the album 
rating information (0 to 5 stars). Clicking on it will change the album rating. Note that to 
set rating of value 0, the easiest way is to drag the value with the mouse to the left like if 
it was a cursor.
The behavior of the album tracks list is otherwise the same as the general tracks list 
view.

View	OpEons	&	Grouping	
The View Options window is raised by using the Show View Options command of the 
View menu or  Cmd J shortcut.

�
As for the tracks list view, the sort order of the albums can be configured in the list 
presenting the sort criteria by decreasing order of priority. They can be changed by 
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clicking on them, along with the order (ascending & descending). The priorities can be 
reordered by dragging sort criteria to their new place.
The second line below the album front cover image can be chosen between the album 
artist, the artist, and the composer (note that in case of an album with different 
composers, only one of the composers or artist is displayed)
In addition, the first sort criteria can be used to split the album list in groups, by selecting 
the "Automatically group albums using the first criteria" option. This gives a view of 
albums as shown below:

�
Each group can be collapsed, showing only the group title with the number of albums in 
it, or expanded to reveal the albums of the group by clicking on the arrow on the left of 
the group title line.
All groups can be collapsed at once (or expanded) by clicking on one of the two buttons 
located at the bottom right of the view.

�
Note that albums that have tracks belonging to different groups will be split among those 
groups.

Switching	views,	highlighEng	playing	track	
Switching between view types (list or album) is done by selecting the view type by  
clicking on the wished one as shown below:

�
In any view, the currently playing track can be highlighted (when present in the currently 
viewed playlist) by using the "Scroll to playing track" command of the View menu, or 
using Cmd L shortcut.
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Recycle	bin	
The Recycle Bin can be opened by using the "View Recycle Bin" command of the View 
menu.

�
It presents the list of tracks that have been deleted from the library (see Deleting tracks 
for how to), sorted by album and track number.

Restoring	tracks	back	to	the	library	
By clicking on "Restore selected tracks" button, the selected tracks will be placed back 
into the library.

DeleEng	permanently	tracks	
By pressing on the "Delete selected audio files" button, the audio files corresponding to 
the selected tracks will be deleted from disk.
Warning: For local volumes this will mean the audio files are moved to the trash, but for 
network shares, the audio files will be deleted permanently. An additional warning 
message will ask to confirm this permanent, not undoable operation.
Please note that some audio files may contain several tracks (e.g. SACD ISO images, 
Cue Sheets). In this case, deleting permanently the audio file will remove all of its tracks 
from the database. This is stated in a special warning message as shown in the example 
below:

�

Hyperlink	navigaEon		
• All artist names are clickable to get the selected artist albums
• All albums names are clickable to get all the album tracks as well as all the albums of 

the same artist. 
As a result, a new item “Browse” is created in the “Sources” pane, to easily come back 
to the navigation. 

�20



Audirvana Plus 3.0 User Manual

�
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Full	Text	Search		
As soon as you type text in the search field, it displays the top 3 matching results by 
albums, artists, composers and tracks:

�
When you click on a result of one of these categories (albums / artists / composers / 
tracks), all the results are then displayed in a view corresponding to the “Search” item 
within the “Sources” pane. 

�
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4. Metadata	ediEng	
The metadata for a track, multiple tracks at a time, and an album can be edited by using 
the "Show Metadata" command of the View menu (or Cmd  I shortcut). This opens the 
metadata editor panel on the right of Audirvana Plus window, displaying the metadata of 
the selected items.

�
Its contents are updated when the selection (e.g. track, album) changes to display the 
new selection metadata.
So the metadata panel can be used to show the detailed metadata of a track (or album), 
even when not willing to edit it.

Note that all audio file types are supported for metadata editing, except currently SACD 
ISO images, and Cue Sheets.

Generic	commands	

�
The top bar of the metadata panel tells the type of item currently displayed, and provides 
three buttons for navigating:

- Left arrow: Previous Item (shortcut Cmd -): changes the selection (and displayed 
metadata) to the previous track in the playlist/album

- Right arrow: Next Item  (shortcut Cmd +): changes the selection (and displayed 
metadata) to the next track in the playlist/album

- Cross: Close metadata editor pane (shortcut Cmd I)

�
When any metadata value is modified, two buttons appear at the bottom of the metadata 
editor panel as shown above:
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- Save: (shortcut Cmd  S) Save to Audirvana Plus database and to the 

corresponding audio file (even all tracks audio files in case of an album editing) 
the changes. The corresponding audio file needs to be accessible for the save 
operation to work

- Revert: (shortcut Cmd  .) Discard any changes, and revert to the tracks previous 
values
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Single	track	metadata	ediEng	
When a single track is selected (in tracks list view or in the track lists of an album in 
album view), the metadata panel looks like below:

�
It presents four blocks of metadata that can be collapsed or expanded by clicking on the 
Hide (or Show) button on the right of their header bar.

�
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File	&	General	
The first two blocks show the most usual metadata for and audio track:

�
1. Corresponding audio file name, and full path (the full path can be hidden by 

clicking on the small triangle left of the file name). Clicking on the arrow on the 
right of the path reveals the audio file in a Finder window.

2. Audio file characteristics, including the dynamics information: ReplayGain, Peak 
sample value, Loudness Dynamic Range (EBU R128 3342), and Dynamic Range 
(DR) rating. The button Recompute ReplayGain triggers (re)analysis of the audio 
file dynamics.

3. Track title, Grouping title. Example of usual use of the Grouping metadata is to 
group movement tracks of the same piece (e.g. in classical music a concerto 
made of three movements) where the grouping title is the name of the piece, and 
the tracks individual titles are the movement names. The track title can be 
complemented with a name used for sorting.

4. Artists list, Composer name. When typing the first letters of the name, a list of 
artists/composers already in the database is presented in a popup menu to allow 
for faster typing, and help avoiding duplicates due to typos.

5. Genre name. When typing the first letters of the name, a list of genres already in 
the database is presented in a popup menu for faster typing.

6. Track number, total track count in the set/disc
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7. Disc Number, total discs count in the set
8. Year. Usually the recording year, BPM (Beats Per Minute)
9. Rating. Track individual rating from 0 to 5 stars. Note that to set the value of 0, the 

easiest way is usually to drag the rating to the left as if it was a cursor.

Extended	

�
1. Conductor. The name of the conductor (usually in classical music)
2. Ensemble. The orchestra or band name
3. Soloist. The name of the soloist
4. Instrument. The main instrument (e.g. Piano, Violin, Guitar)
5. Style. The piece format (e.g. Sonata, Concerto, Symphony, Opera) or a style 

detailing the genre (for non classical music)
6. Period. The period of the music (e.g. Baroque, Romantic)

The Conductor, Ensemble, and Soloist are automatically added to the artists list of the 
track (they are all artists).

Album	

�
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1. Album title. Changing the title enables to attach the track to already existing 

album (when selecting one from the list in the popup menu that appears when 
typing the first letters of the album title), or create a new one.

2. Album artist name
3. Album image.

The album information cannot be changed in the track metadata editor. Album title, 
artists, image, rating can be modified in the Album metadata editor. The Album metadata 
editor is displayed when an album is selected and no track is selected.

Comments	

�
Free text comments.
Note that the INVERTPOLARITY keyword in comments is recognized by the playback 
engine to invert the polarity of the track before playing it.

MulEple	tracks	
When multiple tracks are selected, the metadata panel displays the metadata fields 
whose values are common among the selected tracks. The other fields are left empty.
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Album	
When an album is selected, whole album specific metadata can be edited:

�
1. Album title. Enables to change the album title
2. Album artist. The (main) artist of the album
3. Album front cover image. This can be changed either by dropping a new image 

on it, or by pressing the change button and then selecting an image file in the file 
selection popup window.

4. Album rating. The whole album rating from 0 to 5 stars. Note that to set the value 
of 0, the easiest way is usually to drag the rating to the left as if it was a cursor.

Example	of	metadata	mass	update	
You find inconsistencies in some metadata tags attached to the tracks in your library, like 
for example with the Genre one where Pop/Rock can be written for some tracks as 
PopRock, Pop-Rock, Rock Pop, or even Pop Rock.
Such a situation will make more difficult finding a track or an album (e.g. using the 
Grouping feature of the albums view) by Genre.
There is any easy way to fix this:

- Switch to track list view, in the main Library (“Music” selected in the left panel)
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- Open the structured filter browser by clicking on its title located just above the 

tracks list
- Select only one criteria: Genre
- Select in the values list just below all the Pop/Rock, PopRock,…
- In the track list below, you get all tracks that are of Pop/Rock genre. Select them 

all using Cmd A shortcut.
- Open the metadata editing panel if it is not already open (Cmd I shortcut)
- Edit the Genre tag, setting Pop/Rock
- Click on the Save button.
- That’s it!

ArEsts	Editor	
The Artists Editor is raised using the View menu command Show Artists List. It makes 
possible to rename the name of the artist displayed and the one used for the sorting. 

�
In the previous example view, any change appears in green color before “Save 4 artists”.

Please note saving those changes can take some time, especially if the renamed artists 
are in numerous tracks. All audio files referencing the renamed artists are updated in this 
save process.
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5. Legacy	iTunes	integrated	mode	
Audirvana can be fully controlled by iTunes for the playback operations (tracks selection, 
play/pause, seek, … the usual iTunes way of playing music). This also gives you the 
opportunity to use the Remote application running on iPhone or iPad for remote control.
But note that the sound quality will be affected by having iTunes running along with 
Audirvana Plus.

In this mode, the Audirvana Plus main window is still active and can be raised if desired 
by clicking on the Audirvana Plus dock icon.
Although iTunes is in control, the parameters set in the Audirvana Plus user preferences 
still take precedence over any iTunes/AudioMidi Setup similar configurations.

Note that Audirvana Plus will play all iTunes music files (except DRM protected, tracks 
on the Cloud or on Home Sharing libraries), and automatically deactivate itself for the 
Internet radios that will still be played directly by iTunes.

You can switch between the classic playlist mode and the complete iTunes integration 
by using the iTunes Integrated Mode command in the Audirvana Plus menu.

This is the Audirvana Plus window in iTunes integrated mode:

�

Transport	BuUons	
Refer to the library description of the Transport controls

Volume	Control	
Volume Knob: There are three types of volume control, depending on the device 
capabilities, and the user preferences:

- Master (red cursor): the device provides a remote volume control feature that is 
inside the DAC and normally of optimal quality. See your DAC user manual for 
this.

- Digital (blue cursor): typically digital volume control at the device driver level, so 
still in the computer, with potential associated resolution loss. Should typically be 
set at 0dB to ensure bit perfect output.

- Dithered (green cursor): volume control computed by Audirvana Plus, with 
dithering to strive to maintain the best possible sound quality for this digital type of 
volume control.
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The current value of volume control is displayed under the knob.
If the device provides no volume remote control and dithered volume control is not 
enabled in user preferences, the volume control knob is inactive.
Depending on the user preferences, the knob is rotated using a vertical (default), 
horizontal or rotational motion of the mouse.

Other	buUons	
Disp. Off: Hide all Audirvana windows

Power: Immediately terminates audio playback and exit.

Inside	the	LCD	display	
The track title, artist, album and composer are displayed in the LCD display.

The album image is gathered from, in order of priority:
- The image embedded in the audio file
- A folder.jpg, cover.jpg image file in the same folder as the audio file
- The first file found ending with Sleeve.jpg, or the first file found with the .jpg 

extension in the same folder as the audio file.

Technical information is given at the bottom of the LCD screen:
- On the left: Playing track file type, and native bit depth and sample rate
- On the right: The DAC current bit depth and sample rate

On the right column are some playback status indicators:
- CPU: the red CPU sign indicates an unexpected pause in audio playback. The 

most frequent source of such issues is a lack of available memory. Try to exit 
other memory hungry applications (e.g. Safari), and/or to reduce the audio buffers 
maximum allowed size (in User Preferences > Audio System).

- INT: the playback is performed in Integer Mode. Best possible quality.
- Inverted icon: the yellow inverted icon indicates that the currently playing track 

audio signal is phase inverted before being sent to the DAC
- Loop icon: toggle button to (un)select loop playback
- Shuffle icon: toggle button to (un)select shuffle playback

Track	playing	posiEon	
The current playing position in minutes:seconds is displayed on the left, and the track 
total duration is on the right of the playing position cursor.
Dragging the playing position cursor or clicking directly on a different position makes the 
playback seek to this position.
Inside this playing position track is given information about the loading progress, in form 
of a grey progress bar. If the whole track can’t fit in a single buffer, then the parts of the 
track currently in memory are shown in dark grey, while the others are in black.
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6. User	Preferences	

General	Se^ngs	

�

Remote	control	opEons	
- Using the Apple Infrared Remote control for play/pause/resume/previous/next and 

volume control. A long key press on the prev or next button will seek backward/
forward the playback position for 10s.

- Using the Apple keyboard media keys for play/pause/resume/prev/next and 
volume control.

Playlists	opEons	
- M3U playlist format can be interpreted like M3U8, that is with UTF-8 character 

encoding. Note this is the way iTunes handles these M3U files
- Automatically start playback when Audirvana is opened with a track or playlist 

(usually when double-clicking on such a file in the Finder)
- Save the current playlist when exiting, and automatically reload it the next time 

Audirvana is opened
- Display playlist, library tracks using a larger font

ApplicaEon	Updates	
Audirvana Plus can automatically connect to audirvana.com server to check if an 
updated version is available, and propose to download it.

Miscellaneous	opEons	
- During playback, Audirvana Plus can deactivate the screen saver
- Some user operation warnings (e.g. delete tracks from library) can be 

deactivated. This command reactivates them.
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Audio	System	Se^ngs	

SelecEng	the	Audio	Device	
Audirvana Plus uses a hot plugging mechanism: you select your preferred Audio Device. 
It is used if available (connected) when starting playback, otherwise the system default 
device is used.
You can select your preferred audio device by clicking on the “Change” button in the 
Preferred Audio Device paragraph.
The preferred (or default if not connected) audio device name is displayed in the Active 
Audio Device paragraph, as well as its handled sample rates.

MQA	Device	
MQA devices (decoder or renderer) are automatically detected. If your MQA device is 
connected through a S/PDIF connection, it then can’t be detected as such. You then 
have the possibility to set manually if it is a MQA decoder or MQA renderer.
When a MQA track is played, any audio processing after the MQA decoding 
(upsampling, audio units, software volume control, …) is disabled to send an 
authenticated MQA signal to the DAC. Even more, for MQA decoders, the signal is not 
decoded in Audirvana Plus.
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DSD	playback	
These options (just under the list of available sample rates) enable to select the way 
DSD audio is sent to the DAC, and the (if needed) DSD to PCM conversion algorithm:

- Native DSD Capability: Automatic Detection should work for nearly all DACs. 
Although, if the native DSD capabilities of your DAC are not automatically 
recognized (DSD64 and/or DSD128 not highlighted), you can force native DSD 
streaming  (DSD over PCM standard 1.0 is the most common streaming method 
found in recent DSD DACs)

- DSD to PCM Algorithm: When not using native streaming, the DSD signal needs 
to be converted to PCM before being sent to the DAC. 64bit Multistage gives the 
best results and should be used except if you have CPU performance issues. 
Simple Decimation (the algorithm used before version 1.3) enables to convert to 
96kHz for devices limited to this sample rate and not offering 88.2kHz.

Low	level	playback	opEons	
The options should normally not be changed as the best mode is automatically used 
when all they are enabled (“plug and play” concept)
Exclusive access mode: When playing Audirvana Plus takes full control of the audio 
device, preventing any unwanted interferences from other applications (e.g. system 
beeps, …).
Direct Mode: In this mode Audirvana Plus bypasses completely CoreAudio, including its 
low-level layers. This enables a further shorter audio signal path for better sound quality, 
and gives possibility to enable Integer Mode in Lion and later.
Integer mode: In this mode Audirvana Plus directly sends the audio data to the lowest 
level in CoreAudio, bypassing the driver audio mixer and the format converter. This 
enables to achieve very high sound quality.
There are two different streaming modes in Integer Mode:
Mode 1 that brings the highest transparency, and soundstage depth
Mode 2 that is more on the warm side
Choose the one that fits the best your system and listening tastes.
Note that not all audio devices support Integer Mode, and only the green “INT” indicator 
during playback in the main Audirvana Plus window will show Integer Mode is effective. 
More information in Audirvana: OSX Bit Perfect and Integer Mode

Audio	buffers	memory	allocaEon	
Set the maximum amount of memory Audirvana Plus can use for loading the audio 
tracks in memory. Increasing this value will reduce further the disk accesses and the 
associated interferences.
But a too high value can lead to memory exhaustion (especially if other memory hungry 
applications such as Safari are running), and cause RAM swapping to disk that’ll be 
audible as audio drop outs.
As a rule of thumb it is best to leave at least 2.5GB RAM to the OS.

Bridge	+	DAC	configuraEons	
In the case the Mac is connected to bridge on which the DAC is then connected using a 
S/PDIF, i2S,… connection, you can enter the DAC limitations to prevent Audirvana Plus 
from attempting to use unhandled sample rates. Set the “Max spl rate limit” for this.

�35



Audirvana Plus 3.0 User Manual
To give enough time to the DAC to synchronize its clocks upon a sample rate change 
(and avoid missing the first notes of a track), set the right Spl rate switching latency 
depending on you DAC (e.g. the advanced synchronization locking of the AMR DP-777 
may need up to 4s).

In addition if the bridge is offering both 24bit and 32bit bitdepth, you can limit the 
bitdepth to 24bit by selecting Limit max bitdepth to 24bit instead of 32bit.

And for DACs that don’t mute their analog outputs during a sample rate change as they 
should, resulting in noise during sample rate change, you can enable the Mute during 
sample rate change to help reduce this unwanted noise.

MulEchannel	capability	
The total number of channels of the audio device is shown, as well as the channels 
configuration in use.
In the case the audio device is used only in two channels (stereo) output, the option Use 
as stereo only can be used to optimize the audio path.

The channel configuration is the one set using the OS X AudioMidi Setup application:

�
After having selected the audio device in the list (left of the main window), click on 
Configure Speakers… to raise the speakers selection popup. There you can set the 
channel mapping for the multichannel configuration (or Stereo if you have selected the 
Use as stereo only setting).
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Note that restarting Audirvana Plus is needed after any change made in the channels 
configuration in AudioMidi Setup.

Audio	Filters	Se^ngs	

�

Sample	Rate	Conversion	
Sample Rate Conversion happens when

- The audio device does not handle the audio track sample rate
- Upsampling is forced.

Two different Sample Rate Converter algorithms are proposed: the standard Apple 
CoreAudio, or the gold standard iZotope 64-bit SRC.

Sample	Rate	Converter	Se^ngs	
Use the quality slider to set the desired quality level.
Note that with high initial sample rates, the best quality setting (especially for Apple 
CoreAudio) may be demanding too much computing power for some Macs (thus giving 
in playback pauses).
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For iZotope 64-bit SRC, you have access to advanced detailed parameters to tune the 
sample rate converter filters:

- Steepness: steepness of the transition band of the lowpass filter. Higher 
steepness will reject unwanted frequencies but cause more ringing in the time- 
domain and a higher CPU load

- Max filter length: controls the memory (and CPU usage) used by the resampling 
filter. Default value (500k) should be sufficient for most applications. Can be 
increased for getting vey high quality output for very high sample rates (e.g. DSD 
downsampling)

- Cutoff: cutoff frequency is computed by multiplying the Nyquist frequency by the 
value of the cutoff scaling parameter. Larger values of cutoff scaling offer a flatter 
pass-band, while smaller values offer better aliasing suppression

- Anti-Aliasing: the amount of suppression in the lowpass filter’s stop-band. Any 
frequencies in the stop-band, which are not fully attenuated, will result in aliasing, 
which is when these unwanted frequencies are mapped to different frequencies 
and mixed into the output. Use higher values for better quality and use lower 
values to minimize CPU load.

- Pre-ringing: all lowpass filters are characterized by the amount of ringing they 
introduce into their output. The steeper the filter, the greater the amount of 
ringing. There are two general types of ringing: pre-ringing and post-ringing. Pre-
ringing will smear transients earlier in time, while post-ringing will smear 
transients later in time. This control allows users to select pre-ringing, post-
ringing, or anywhere in between. A value of 1.0 produces a linear phase filter with 
equal pre- and post-ringing. A value of 0.0 produces a minimum phase filter, 
which offers no pre-ringing but has non-linear phase distortion, which can be 
objectionable. Setting intermediate values allows a continuous tradeoff between 
pre-ringing and post-ringing and allows users to linearize phase in the pass-band 
as much as possible.

Forced	Upsampling	
This gives the possibility to select to force upsampling (or not), to:

• Power of 2 of the track native sample rate (e.g. the highest available on the audio 
device of 88.2, 176.4 or 352.8kHz for a track natively at 44.1kHz)

• Maximum sample rate of the audio device
• Twice the track native sample rate (if possible on the audio device)
• Specific sample rate for each track native one (selection done by clicking on Edit 

custom settings)
• DSD (available only with a DSD compatible DAC, and iZotope sample rate 

converter). In addition to the iZotope filter settings, the sigma-delta modulation 
filter can be chosen. To avoid DSD upsampling clipping issues (leading to 
silence), the volume of too loud tracks must be reduced. For tracks with 
ReplayGain and sample peak values, the need and the amount of volume 
reduction is computed automatically. For others, a fixed amount of safe volume 
reduction can be specified here.

Audio	Signal	Polarity	
These options give the ability to invert globally the polarity of the audio signal, either for 
all tracks, or for only the tracks that have the invertpolarity keyword in their comments.
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Audio	Volume	Se^ngs	

�

Volume	control	type	
Your DAC may or may not offer remote volume control (master or digital).
In this case, the volume can still be controlled by Audirvana Plus, but this will mean a 
reduction of the audio signal precision as it’ll be performed in the digital domain.
Thus a dithering algorithm is used to lessen the audible impact of this digital volume 
control. For improved sonic performance, the dithering operation is automatically 
bypassed when the volume is set to 100%.

Dithering	engine	tweaking	
When using dithering volume control, you have access to advanced parameters for the 
dithering engine:

- Dithering Type: Controls the type of dithering. MBIT+ contains two traditional 
dithering types as well as the proprietary MBIT+ dithering type. Type 1 dither is a 
traditional dither based on a rectangular probability distribution function (PDF), 
and Type 2 dithering is a traditional dither based on a triangular PDF. MBIT+ 
dither is based on a proprietary algorithm designed to offer superior results when 
used with all types of source material. Some users will appreciate a choice of 
dithering type, but for most users the MBIT+ type should be optimal in all cases.

- Shape: When using Type 1 or Type 2 dither, this controls the noise shaping. 
Dithering noise can be shaped in order to make it less audible. Simple noise 
shaping performs simple high-pass filtering on the noise. Clear noise shaping 
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aggressively moves the noise toward the Nyquist frequency. Psych 5 is a 5th-
order filter designed to move noise away from audible bands, and Psych 9 is a 
9th-order filter with similar characteristics.
When using MBIT+ dither, this controls the amount of noise shaping. The choices 
range from no noise shaping to very aggressive noise shaping, providing 
approximately 14 dB of audible noise suppression, at the expense of a higher 
noise floor.

- Level: When using Type 1 or Type 2 dither, this controls the number of bits used 
to perform dithering. In most cases, 1 bit will suffice, but “over”-dithering with 2 
bits can occasionally be useful.
When using MBIT+ dither, this controls the amount of dithering. The None and 
Low settings can leave some non-linear quantization distortion or dither noise 
modulation, while higher settings completely eliminate the non-linear distortion at 
the expense of a slightly increased noise floor. The Normal setting should suffice 
for most cases.

- Max bitdepth: The bitdepth offered by the audio device interface (e.g. USB) may 
be higher than the one the DAC can handle, or even the DAC linear range may 
be in a lower bit depth (20bit instead of 24bit). This enables to use MBIT+ high 
quality dithering to deliver signal best tuned for the DAC by fitting its linear range.

- AutoBlanking: It is sometimes convenient to completely suppress dithering noise 
during periods of digital silence. When auto-blanking is enabled, MBIT+ will mute 
dither output when the input is completely silent for at least 0.7 seconds.

- MinimizePeaks: Dither noise is random in nature and has a very low amplitude. 
However, after noise shaping, especially in aggressive dithering modes, the high-
frequency dither noise is significantly amplified, and the overall dither signal can 
show spurious peaks up to - 60 dB FS. If such high peaks are undesirable, you 
can enable the Limit Peaks option to effectively suppress the spurious peaks in 
the noise-shaped dither.

- Silence Harmonics: If, for some reason, any dithering noise is undesirable, 
simple truncation remains the only choice. Truncation results in harmonic 
quantization distortion that adds overtones to the signal and distorts the timbre. In 
this case you can enable the Suppress Harmonics option to slightly alter the 
truncation rules, moving the harmonic quantization distortion away from 
overtones of audible frequencies. This option doesn't create any random dithering 
noise floor. Instead it works more like truncation, but with better tonal quality in 
the resulting signal. This option is applicable only in the modes without dithering 
noise and without aggressive noise shaping.

You can find detailed explanation on MBIT+ and its parameters in this paper: http://
www.izotope.com/products/audio/ozone/OzoneDitheringGuide.pdf

Max	volume	level	
You may want to limit the maximum volume level set when turning the volume knob to 
100%.
Use this setting for this purpose.
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ReplayGain	loudness	normalizaEon	
“Replay Gain is a standard (…) to measure the perceived loudness of audio in computer 
audio formats. (…) This function allows players to normalize loudness for individual 
tracks or albums. This avoids the common problem of having to manually adjust volume 
levels between tracks when playing audio files from albums that have been mastered at 
different loudness levels.”1

The loudness volume may vary greatly between albums and tracks. To remove the need 
to manually adjust the volume of the preamplifier, the volume leveling can be performed 
automatically to a normalized value of average loudness of -14dB.
These settings allow to switch on this automated loudness volume normalization during 
playback at the album or individual track level.
Please note the tracks/albums dynamics need to have been analyzed before starting 
playback. This is triggered either individually using the Recompute ReplayGain button in 
the track/album metadata editor, or in batch mode using the File menu Library > 
Compute Albums ReplayGain command.
In addition, volume leveling or dynamics analysis can’t be done with DSD tracks due to 
the DSD format that is not compatible with any volume operation.

Audio	Units	

�
Up to four Audio Units filters can be used to tune / apply effects to the sound to modify 
the response for applications like system/room active correction.
Select Use AudioUnits effects to enable the Audio Units plugins support.
Then select in the drop down lists the Audio Units you want to use.

 From Wikipedia1
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�
Configuration of each Audio Unit plugin can be done either offline by clicking on 
Configure (Click on Apply when done with the settings to save them).
Presets for each Audio Unit type can be saved or recalled. Note that the presets can be 
saved on the user domain, or local to the system (possible only if the user has the 
authorization to modify system settings). User and Local presets can be deleted by 
clicking on the “-“ button at the bottom left of the presets list, after selecting the preset to 
delete.
Or configuration can be made in realtime during playback by using the option Realtime 
AudioUnits control and setup (popup windows will open upon playback start for each 
Audio Unit).
Note that with the realtime setup the AudioUnits rendering is done during playback, and 
thus, for maintaining the optimal sound quality, this option should be set to off after the 
AudioUnits configuration is completed. This will ensure the rendering is done during 
track loading process, before playback.

The audio signal processing is done in the following order:
1) File loading and decoding
2) Sample rate conversion (if needed)
3) Audio Units in the top to down order
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SysOpEmizer	

�
Spotlight, Time Machine are resource hungry background processes that create 
important activity of the disk drives, and thus interferences detrimental to the sound 
quality.
The automated detection of iDevices on USB can even cause audible clicks.

It is therefore strongly advised to enable SysOptimizer. It will deactivate these interfering 
background services at playback start, and reactivate them upon stop.

In addition, SysOptimizer can increase the priority of Audirvana Plus during playback to 
maximize the precision of the audio streaming.

�43



Audirvana Plus 3.0 User Manual
Library	

�

Local	library	content	
The library contains the tracks coming from the audio files in the selected folders and/or 
in the iTunes database.
There are two ways to do this import:

1) By adding the folders to sync with Audirvana Plus.
This is the recommended method, as any folder content update will then be 
automatically pushed to Audirvana Plus (except for the network volumes). Adding new 
files inside these folders will make their tracks automatically appear in Audirvana Plus.

- Under "Select the folders to add to the library", click on “+” button at the bottom 
left of the list to add a new folder to synchronize. This will raise the folders 
selection window where you’ll select one or more folders to add to the list.

- You can force a synchronization by clicking on the “Sync” button located on the 
row of the folder to synchronize.

- To delete a folder from the synchronization list, and remove all its tracks from 
Audirvana Plus library, select it and press the “-“ button.

2) The other method is to synchronize with iTunes by importing iTunes library.
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- Click on “Sync” to initiate the synchronization. This process is made in the 

following steps: 1) import/update the tracks that are more recent in the iTunes 
library, 2) update in iTunes the tracks modified in Audirvana Plus (this will launch 
iTunes during this step). In case of synchronization conflict, the priority is given to 
changes made in Audirvana Plus over in iTunes.

- Click on “Delete” to remove the tracks and playlists imported from iTunes. The 
tracks that are also in folders in the synchronization list will be preserved.

Note that this operation will need to be repeated each time the iTunes library is 
updated. As there may be some latency in iTunes to save its latest updates, it’s better to 
quit iTunes before requesting a new synchronization.
The following information is not synchronized from iTunes:

- Tracks not readable outside of iTunes: DRM protected files (usually ending 
with .m4p extension), the tracks on the cloud and coming from Home Sharing 
libraries

- Non musical tracks (e.g. video, books)
- Criteria of Smart Playlists, only the tracks are imported for these

The following information is not synchronized to iTunes:
- Advanced metadata not handled by iTunes (e.g. soloist, conductor, period)
- Play count and last played date
- Playlists (single way: only imported from iTunes, any changes done to these 

playlists imported from iTunes in Audirvana Plus is erased upon the subsequent 
synchronization)

In addition, with this method, you need to ensure all your music files folders are 
accessible (mounted) before launching the synchronization.  Tracks whose file is not 
accessible during the synchronization will not be imported.
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Streaming	account	

�
If you have a streaming account, you can connect it by clicking on « Connect ».
Currently supported streaming services are:

• Qobuz, subscription from qobuz.com
• TIDAL, subscription from tidal.com
• HighResAudio VirtualVault, subscription from highresaudio.com

Upon connection you’ll get the streaming service source for general browsing and 
search, and its playlists automatically listed in the Sources view, left of Audirvana Plus 
view. Example for Qobuz given below:

�
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iTunes	[Only	for	legacy	iTunes	integrated	mode]	

�
For best sound quality, Audirvana Plus can completely deactivate sound playback by 
iTunes. Note that this also prevents any other application to output sound during 
playback.

In addition, to increase further the Sound Quality, you can deactivate convenience 
functions:

- Volume Control: Audirvana Plus interacts with iTunes on a regular basis to 
exchange the volume control values. This option deactivates this mechanism and 
thus iTunes (and iPhone/iPad Remote) volume slider is not used anymore.

- Play Position: Audirvana Plus communicates the play position to iTunes, and 
seeks to a new position when the slider in iTunes is moved. This option 
deactivates this mechanism and thus iTunes (and iPhone/iPad Remote) play 
position slider is not used anymore. Furthermore, the time indication remains to 
00:00 during playback.

7. Setup	&	OpEmizaEon	
SelecEng	the	DAC	for	audio	output	
In User Preferences, Audio System, click on the Change button (in the Preferred Audio 
Device section on the top of the panel).
Select the DAC in the drop down list of the popup window.
Click on Select to close the popup.
The DAC name shall appear under Active Audio Device.

Note	for	Macs	before	2008	end	
If you encounter some short and frequent audio dropouts and you have a Mac from 
before 2008 end, this may be due to insufficient USB bus power. A workaround consists 
in plugging the DAC in a USB powered hub that is connected to the Mac. Of course no 
other device shall be connected on the same hub.
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General	OpEmizaEons	

Plug	the	DAC	on	a	dedicated	USB	bus	
The USB plugs on your Mac are not equivalent. One may be already shared with an 
internal peripheral like the built-in iSight webcam.

To check your DAC is connected to the right plug:
1. Use the “System Information” application you can launch from the Apple menu, 

popping the “About this Mac” dialog. Then click on “More info…”
2. Scroll the left column down to the Hardware section
3. Select USB
4. Check on the top right pane that your DAC is listed alone under a “High speed 

USB bus” section

Connect any other peripherals, such as external hard drives, to another bus, or even to 
a Firewire or Thunderbolt one.

Enable	SysOpEmizer	
Enable SysOptimizer in the User Preferences to have more advanced optimizations 
performed automatically at each playback. Set priority to Extreme.

DeacEvate	screen	saver	
Using the option in the General page of Audirvana Plus preferences

Disable	energy	saver	
In System Preferences, Energy Saver, set the Computer Sleep and the Display Sleep 
time to Never.

Minimize	use	of	other	applicaEons	
Other applications might have peak demands on the CPU, the RAM and/or the hard 
drive, degrading the sound quality, even down to skips in audio playback in case of 
memory swapping to disk.

iZotope 64-bit SRC™, iZotope MBIT+™, iZotope® ; © 2011-2016 iZotope, Inc. All Rights 
Reserved
Designed under license from MQA limited. The MQA logo is a trademark of MQA Limited.
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